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Accessibility Checklist
Check each option off of the list as you verify it 

General Requirements 
__ Begin with the intention of accessibility 

__ Ensure that templates being used start out as being accessible 
__ Branding or color scheme meets contrast requirements 
__ Use MS Word or PowerPoint whenever possible 

__ Run accessibility check (Review menu) before finalizing 
__ If not using MS products, use an accessibility checklist 

__ Set the document properties 
__ Title (File menu, Info) 
__ Author (File menu, Info) 
__ Language (Review menu) 

__ Save as PDF (accessible) 
Text 
__ Minimum font size for Word is 11 pt and for PowerPoint it is 18 pt 
__ Keep sentences short and easy to follow (8th grade reading level) 
__ Use left justification for everything and keep everything on the left 

margin 
__ Never use full justification 

__ Use a font commonly known to be accessible 
__ Avoid angled or vertical text 
__ Use paragraph spacing instead of extra return characters 
__ Line spacing should be at least 1.0; commonly 1.5 
__ Use indents instead of extra tabs 
__ Use native list tool instead of typing bullets 
Links 
__ Use descriptive links instead of URLs 
__ Limit use of the same link 
__ Wording of each link must be understandable with no other 

context 
__ Verify each link is still correct when document is complete 

Images 
__ Images that convey information must have alt text and those that 

do not must be marked decorative 
__ Avoid images with angled or vertical text 
__ Contrast rules apply for images, especially for text over an image 
__ Never use AI services for alt text 
__ Double-check every image, even decorative ones and logos 
Color and Contrast 
__ Dark text goes with light background and vice versa 
__ Do not use color alone to convey information 
Tables 
__ Tables must always have a single, identified header row 
__ If a table has a header column, it must be identified as well 
__ No empty header cells 
__ Empty data cells should say “no data” rather than being left blank 
MS PowerPoint 
__ Every slide within a presentation must have a unique title content 

holder 
__ Links intended for use during the presentation can be in URL form 

__ Use a link shortener for long URLs 
__ Ensure reading order on each slide 
MS Word 
__ Proper use of headings 
Adobe PDF 
__ Run accessibility checker (if available) 
__ Verify reading order and color contrast 
Google Docs 
__ Google support page to check accessibility yourself (there is no 

tool) 



 

 
    

 
    

     
   

  

  
      

     
         

      
 

 
   

   
 

  
    
      

 
   

    
      

     
 

  
 

    
    

     
      

 
 

 

 
 
 
 
 

 

General Accessibility Considerations and Requirements
To paraphrase Section 508 of the Rehabilitation Act, any agency that accepts federal money is required to make public communication and 
documentation accessible to people with disabilities. The Arizona Department of Education (ADE) is one such agency. The Exceptional Student 
Services (ESS) section of ADE takes this requirement very seriously and is also very pleased to accept the requirement, considering that 
accessibility is the right thing to do. The requirement of Section 508 holds true for conferences that ESS funds, so we require that all presentation 
materials be accessible, even those that originate from outside entities. ESS measures accessibility requirements against the WCAG 2.1 AA 
standards. We provide this assistance guide to help you to make your materials accessible. 

Begin with Accessibility in Mind 
Build documents and templates with intention. The first intention is accessibility. The fact is that approximately 20% of people have some sort of 
disability (to varying degrees), and it is crucial to develop public information that is accessible to all people. If your administration or corporate 
structure require specific branding or a certain impressive look, take the steps to ensure that accessibility is not ignored. Branding, for example, can 
sometimes work against requirements for color and contrast (see page 4) or against readability, depending on which and how fonts are used (see 
page 5). 

Templates are a good way to ensure consistency and accessibility. Create templates and include instructions for people who do not use the 
software so often. Re-examine old templates and old versions of your current document or presentation and update them to be accessible 

General Guidance 
Create documents in MS Word and MS PowerPoint whenever possible. Add a Title and 
ensure the Author in the File Menu under Info/Properties. Next, ensure that the appropriate 
language is being used in the Review menu, especially important if you create documents in 
Spanish (or for any other language audience). Adding the title will change the displayed 
document title in the top of the window. If a title is present, AT devices will read the title instead 
of the file name. Finally, run the Check Accessibility tool in the Review menu before posting or 
sharing the document and make adjustments as needed. Note: errors must be corrected for 
accessibility; warnings could go either way and are subject to a reviewer’s verification. 

Best practice for shared or publicly available documents is to make them PDFs. Be sure to save 
a document as a PDF in an accessible format (after you have done all of the verification listed in 
this document). In MS Office, go to File menu, Save As (or Save a Copy), and to the PDF export 
option and select the option that maximizes accessibility. If you are fortunate enough to have 
Adobe Acrobat Pro, you should have an ‘Acrobat’ menu in your MS Office products. If so, use 
this menu (Create PDF button) to save your file as a PDF. (It is a slightly better option than 
Save As.) 

Return to Table of Contents 

https://www.section508.gov/manage/laws-and-policies/
https://www.w3.org/TR/WCAG21/
https://www.w3.org/TR/WCAG21/


 

 
  

    
      

     
  

    
      

  
 

    
    

     
    

     
 

    

     
     

     
      

    

 
   

     
 

     
   

 
  

   
 

     
     

    
  

     
 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 

Text 
Text should be easy to follow and understand. For public documents, best practice is to have a 
minimum font size of 11pt in text documents and 18 pt for presentations. Also, aim for an 8th 
Grade reading level and limit the use of jargon. Documents designed specifically for 
professionals can contain more advanced language and more liberal use of jargon. 

• Have someone review the document who was not involved in its creation to look for 
spelling/grammar errors and confusing content. 

o Pro tip: someone who is not an expert in the subject matter can be ideal for 
spotting confusing content. 

Keep sentences short. Keep text on the left margin and use left justification; limit use of 
centering text to document titles and maybe slide titles. Never use full justification because of 
the odd spacing it often creates. The most commonly lauded fonts for accessibility are Verdana, 
Tahoma, Arial, Georgia, Palatino, Lucida Sans/Lucida Grande, Calibri, Times New Roman, and 
Helvetica. Finally, avoid angled or vertical text, even in images. 

Line spacing should be at least 1.0; 1.5 is commonly used. Use paragraph spacing judiciously to 
avoid extra carriage returns (return characters); AT devices sometimes read each return 
character, which is a waste of the user’s time or possibly confusing. Instead of using several 
tabs to line up text, use the Indent feature. (Tabbing or indenting is counter to keeping text on 
the left margin, but use indenting if you must.) For lists or outlines, be sure to use the List 
buttons (bullet points, numbers, outlines) instead of typing the characters and trying to space 
the lines. AT devices can interpret lists easily, so using these tools can save a lot of trouble. 

Links 
Use descriptive links instead of the URL (example: Arizona Department of Education website 
rather than www.azed.gov). Be both as descriptive as possible and concise as possible. (It is 
a balancing act.) 

• take the session survey as opposed to click here 
• best practice: words to avoid in links: here, this, link 

Each link within a short document should be unique; in longer documents, try not to use 
duplicate links more than once per page or section (use your judgment). 

Links should be worded in such a way that they can be understood with no other context. For 
some practice, copy the words of each link into a separate, plain text document. Give it to 
someone else and see if they can tell you the full meaning of the link and where the user will 
end up. Then, verify (click on) each link when you suppose your document to be complete, 
especially if it is a link you have used many times before; they sometimes change over time. 

Return to Table of Contents 



 

 
     

    
  

 
     

        
   

    
       

 

     
    

   
      

  

  
   

    
 

      
    

     
 

 
  

   
     

 
  

    
 

    
    

 
  

     
 

 

 

 
 
 
 
 
 
 

 

Images 
Every time you place an image into your document, ask yourself a question: Does this image 
convey information? If the answer to the question is no, then the image should simply be 
marked as decorative (in some software, this is called archiving). 

If the answer is yes, then the image must have alternative text (commonly shortened to alt 
text). Alt text is background text, not visible in the document, that Assistive Technology devices 
such as screen readers can interpret. The point of alt text is to describe the image accurately so 
that a person who is blind or visually impaired can interpret the meaning of the image in relation 
to the nearby text. Also, avoid images of text where the text is angled or vertical. 

To add alt text, right-click on the image. In the menu that appears, you should see something 
like ‘Edit Alt Text’ (the exact wording may vary depending on what software you use). Do your 
best to describe the image accurately and without bias. Do not provide any context to the 
surrounding material; let the reader infer the full context. Finally, as with descriptive links, 
mentioned above, balance being fully descriptive and fully concise. There is no need to begin 
with ‘image of’ or ‘picture of’; the AT device will take care of that for you. 

Color and Contrast 
It is important to pay attention to contrast of colors. Color and contrast make some documents 
difficult to read for people with certain visual impairments. 

The simplest rule is that dark text goes on a light background and vice versa. The same rule 
applies with images, but they are a more complicated to work with. If you want to add text in 
front of an image, add a rectangle or other appropriate shape to provide a background for the 
text. 

Do not use color alone to convey info (e.g., green font for something positive and red for 
negative). People with certain kinds of color blindness cannot infer meaning from color alone. 
Accompany the use of color with symbols and end notes, or maybe italics and underlining. 

WebAIM is an excellent resource for accessibility information. They specialize in website 
accessibility but have plenty of info about documents as well. WebAIM offers two tools to 
highlight in this guidance: 

• Compare colors as foreground (text) and background via WebAIM’s contrast check tool 
• Compare colors as link, used link, and background via WebAIM's link contrast check tool 

Contrast between background and foreground (text) must be maintained at the minimum at a 
ratio of 4.5:1. For large text (18 pt font size or bigger), the ratio must be 3.5:1 or higher. 

Return to Table of Contents 

https://webaim.org/
https://webaim.org/resources/contrastchecker/
https://webaim.org/resources/linkcontrastchecker/


 

 
   

    
  

     
 

   
 

   
 

 
 

  

 
  

  
      

   
     

    
 

    
     

 
  

 
  

      
   

  
   

 

 

 
 
 
 
 
 
 
 
 

 

 
 
 
 

Tables 
Do not use Table structure for layout or format; Tables are meant to be used for data tables. A 
header row in a Table is crucial and must be marked as such; not every Table requires a 
header column, but when one is present, it should also be marked. 

• Simple rule: if there is not a proper header row, do not use a Table. 

Avoid complex tables, meaning when there is more than one header row or column. Also, avoid 
leaving header cells blank; the sole exception is if the top left cell, one that is over a header 
column, could be empty. Finally, if you have blank data cells (it happens), be sure to type ‘no 
data’ or something similar in those cells rather than having a dash or keeping the cells blank. 

Software-Specific Guidance
Continue to abide by the guidance listed above and include the info below. 

MS PowerPoint 
Every slide must use the Title content holder. Titles must not be duplicated within the same 
presentation. If you have a series of slides within one presentation: 

• If there are two in the series, end the second title with “(continued)” 
o Do not abbreviate “continued” 
o It is OK to make it smaller text to keep the eye focused elsewhere 

• If there are three or more, mark them “(slide 2 of 5)” and so on 

Links that are intended for use during the presentation session should be written out in URL 
form; for very long links, consider using a link shortener (like Bitly) or a QR code. 

• Use CamelCase in links and URLs, which helps screen readers make sense of 
smooshed-together words. 

o Example: SpecialEducation as opposed to specialeducation 

Reading order ensures that the document makes sense according to English reading 
convention: we read from left to right, then top to bottom, and AT devices interpret reading order 
the same way. Reading order is more difficult to ensure in presentations than in text documents. 
There is a new Accessibility Menu in MS Office products when you are doing accessibility 
checks. It makes verifying object order (reading order) and adding slide titles much easier. 

Return to Table of Contents 



 

 
     

    
       

 
     

 
    

  
 

 
   

 
 

 
 

  
     

 

    

   
   

   
 

 

 
 

 
 
 
 

 
 
 
 
 

MS Word 
Use the Styles feature in the Home menu for documents of more than a couple of pages, which 
creates a structure of headings. Headings (H#) allow for ease of navigation with AT devices, 
similar to how sighted readers can scan a table of contents and jump to the proper section. 

Headings must go in order. Do not skip any numbers (e.g., H1 to H3 without H2 in between). 

H1 should be used precisely once, only for the title of the document. H2 is applied to the main 
sections of the documents, H3 to subsections, and so on. Try not to go beyond H4. 

Adobe PDF 
The Adobe accessibility checker is very thorough. It is a Tool that requires a paid subscription to 
the Pro version of Acrobat. If you do not have a paid subscription, consider getting it. ESS does 
not have any solid information on how to make a PDF accessible without the paid subscription, 
but it can be done. 

Two items will always appear in the check: color/contrast and logical reading order. These two 
items require manual inspection to allow you to do a final visual check, and then you can right-
click to pass them when you are sure. Make adjustments to reading order before adjusting any 
tags. 

Google Docs and Slides 
Google Docs does not have an accessibility check tool. Browser plug-ins may be available; ESS 
does not have any information on their quality. The best tool in this case is knowledge. Use the 
lessons given above for Word and PowerPoint and apply it to the appropriate document type. 
There is also a pretty good Google support page that gives advice on making Google Docs 
accessible; supplement the knowledge you gained above with the information on this web page. 

Return to Table of Contents 

https://support.google.com/docs/answer/6199477?hl=en
https://support.google.com/docs/answer/6199477?hl=en
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